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Preface 

The purpose of this manual is to provide the user with the information required to 
install version 2.0 of the IHS Emergency Department Dashboard (EDD). 
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1.0 Release Notes 
The EDD is a tool that electronically enables facilities to run and manage their 
emergency and or urgent care clinics. The EDD is dependent on the Resource and 
Patient Management System (RPMS) Emergency Room System (ERS) in the AMER 
namespace. EDD was built on the ERS foundation to enhance patient flow and 
provider communication. 

EDD can be set up to operate as a standalone icon on the staff computer or can be 
accessed from within the RPMS Electronic Health Record (EHR) application. 

EDD gets its data and updates from one of four ways: ERS, Dashboard Edit, or EHR 
data or a combination of all three. 
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2.0 Installation Notes 
Prefix: BEDD 
Current Version: 2.0 

2.1 Contents of Distribution 
The BEDD v2.0 distribution contains the following items documented in Table 2-1. 

Table 2-1: Contents of Distribution 

File Description 
bedd0200xml.zip 
(containing 
bedd0200.xml) 

Ensemble import file 

bedd0200.k KIDS file 

bedd020i.pdf Installation guide and release notes 

bedd020t.pdf Technical manual 

bedd020u.pdf User guide 

2.2 Required Resources 
Table 2-2 contains the RPMS software which is required in order for the BEDD 
software to run properly. 

Table 2-2: Require RPMS Software 

Module Minimum Version 
Veterans Administration (VA) FileMan (DI) v22.0 Patch 1003 

VA Kernel (XU) v8.0 Patch 1015 

IHS/VA Utilities (XB) v3.0 through Patch 11 

ER Visit System (AMER) V3.0 Patch 6 

Patient Care Component PCC Data Entry 
(APCD) 

v2.0 through Patch 10 

IHS PCC Suite (BJPC) v2.0 Patch 11 

EHR 1.1 v1.1 Patch 14 
Lexicon Utility (LEX) v2.0 Patch 1003 

IHS EMERGENCY DEPT DASHBOARD 
(BEDD) 

V1.0 (XML and KIDS Builds) 
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2.3 Before You Begin: Installation Issues 
The Ensemble import file (bedd0200.xml) is being delivered in a zipped 
(compressed) format. It has been determined that transferring the file in an 
uncompressed format will corrupt it so that it will not import properly into Ensemble.  
When retrieving the file therefore, do not extract the file from its zipped state until it 
has been placed directly into the desired import folder. 
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3.0 Installation Instructions 
The process to install version 2.0 of the BEDD application requires the installation of 
two builds. The first build that needs to be installed is an XML release that needs to 
be imported into Ensemble first. Following the XML installation will be a standard 
KIDS build installation. Following the installation of the builds, if the previous 
version of the BEDD application has not been installed in the past, then a number of 
post-installation steps must be completed. 

3.1 Disk Space 
With Version 2.0 of BEDD, approximately 5 MB of disk space on the server is 
needed to install the Cache Server Page (CSP) and Cache Class files contained in the 
bedd0200.xml file.  Additional storage space will be needed to store patient 
information entered through the EDD. 

3.2 Pre-installation 
Before installing the BEDD application, the following items should be completed (in 
no particular order): 

• If possible, initially load the software into a test account, then into the production 
account. There are no routines or globals to remove after the installation is 
complete. 

• Refer to the sample installation instructions for the applicable prompts and user 
responses. User responses appear in bold type. 

• Ensure the other required applications have been installed. 
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4.0 Sample Installations 

4.1 BEDD XML/Ensemble Installation 
This section begins the BEDD installation process. It describes the process of 
importing the BEDD application into Ensemble Studio from an XML file. 

4.1.1 Open Ensemble Studio 
 Click the Ensemble cube in the system tray (at the right end of the Windows 1.

Taskbar) and click Studio, as shown in Figure 4-1. A login ID and password may 
be required. 

 
Figure 4-1: Open Ensemble Studio 

 The Ensemble Studio window is displayed, as shown in Figure 4-2. 2.

 On the File menu, click Change Namespace to open the Cache Connection 3.
Manager Dialog box. 
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Figure 4-2: Ensemble Studio with option to change namespace 

 Select the appropriate namespace from the Cache Connection Manager dialog 4.
box and click OK, as shown in Figure 4-3. 

 
Figure 4-3: Select the appropriate namespace to import to 

4.1.2 Import the bedd0100p1.xml file 
 On the Tools menu, click Import Local as seen in Figure 4-4. 1.
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Figure 4-4: Accessing the Import Local menu option 

 Navigate to the appropriate folder where the file exists, and select bedd0200.xml 2.
and click Open (Figure 4-5), to display the Import dialog box, as shown in 
Figure 4-6. 

 
Figure 4-5: Selecting the XML build to import 
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Figure 4-6: Import Dialog box display 

 In the Import dialog box, all items in the list need to be selected and Compile 3.
Imported Items options needs to be selected. 

 Click OK. After the system compiles the EDD package files, the Compilation 4.
finished successfully in… message appears in the Output pane. 

 A warning dialog box similar to Figure 4-7 may be displayed after the XML file 5.
has been imported. Click OK to continue. 
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Figure 4-7: Studio warning dialog box 

4.2 BEDD KIDS Installation 
 From the KIDS menu, select the Installation menu. 1.

 From the XPD Main -> Installation menu, select Option 1: Load a 2.
Distribution. 

 Type bedd0200.k at the “Enter a Host File” prompt. Please note the file path 3.
might need to precede the file name with the appropriate host path. This is the file 
to retrieve from the appropriate software directory. 

 Type Yes (or press the ENTER key to accept the default) at the “Want to 4.
Continue with Load? YES//” prompt. 

 KIDS file bedd0200.k contains the following installation file: 5.

BEDD DASHBOARD 2.0 

 From the Installation menu, select Option 2: Verify Checksums in Transport 6.
Global. This option provides a mechanism for ensuring the integrity of your 
routines. This step verifies checksums for the components of the Transport global, 
and reports any errors uncovered. 

 Type BEDD DASHBOARD 2.0 as the install name.  7.

Optional: At this time, you can elect to exercise one of the following installation 
options. If you elect to use one of these, use BEDD DASHBOARD 2.0 as the 
install name. 

a. Back Up a Transport Global – this option creates a MailMan message that will 
back up all current routines on the system that would be replaced by this 
release. 

b. Compare Transport Global – this option allows you to view all changes that 
will result from the installation of this patch and compares them with the 
values currently loaded on the system (routines, data dictionaries, templates, 
etc.). 

 From the Installation menu, select the Install Packages(s) option. 8.
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 At the Select Install Name prompt, type BEDD DASHBOARD 2.0. 9.

 Respond to the following prompts as indicated: 10.

a. At the “Want KIDS to Rebuild Menu Trees Upon Completion of Install? 
YES//” prompt, type NO. 

b. At the “Want KIDS to INHIBIT LOGONs during the install?//YES” prompt, 
type NO. 

c. At the “Want to DISABLE Scheduled Options, Menu Options and 
Protocols?//” YES prompt, type NO. 

 Type the device that will print the install messages.  11.

 Exit the Installation menu. 12.

4.3 Sample Cache Install 
Note: User responses appear in bold type. 

Select OPTION NAME: XPD MAIN       Kernel Installation & Distribution 
System 
 
          Edits and Distribution ... 
          Utilities ... 
          Installation ... 
          Patch Monitor Main Menu ... 
 
You have 2 PENDING ALERTS 
          Enter  "VA to jump to VIEW ALERTS option 
 
You've got PRIORITY mail! 
 
Select Kernel Installation & Distribution System Option: Installation 
 
   1      Load a Distribution 
   2      Verify Checksums in Transport Global 
   3      Print Transport Global 
   4      Compare Transport Global to Current System 
   5      Backup a Transport Global 
   6      Install Package(s) 
          Restart Install of Package(s) 
          Unload a Distribution 
 
You have 2 PENDING ALERTS 
          Enter  "VA to jump to VIEW ALERTS option 
 
You've got PRIORITY mail! 
 
Select Installation Option: 1  Load a Distribution 
Enter a Host File: D:\RPMS_TEST\bedd0200.k     *Note: A site specific path 
will be required here                                 
 
KIDS Distribution saved on Jun 04, 2014@20:53:28 
Comment: BEDD DASHBOARD 2.0 
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This Distribution contains Transport Globals for the following Package(s): 
   BEDD DASHBOARD 2.0 
Distribution OK! 
 
Want to Continue with Load? YES//  
Loading Distribution... 
 
Build BEDD DASHBOARD 2.0 has an Environmental Check Routine 
Want to RUN the Environment Check Routine? YES//  
   BEDD DASHBOARD 2.0 
Will first run the Environment Check Routine, BEDD2ENV 
 
                        Patch "AMER*3.0*6" is installed.                         
Use INSTALL NAME: BEDD DASHBOARD 2.0 to install this Distribution. 
 
   1      Load a Distribution 
   2      Verify Checksums in Transport Global 
   3      Print Transport Global 
   4      Compare Transport Global to Current System 
   5      Backup a Transport Global 
   6      Install Package(s) 
          Restart Install of Package(s) 
          Unload a Distribution 
 
You have 2 PENDING ALERTS 
          Enter  "VA to jump to VIEW ALERTS option 
 
You've got PRIORITY mail! 
 
Select Installation Option: 2  Verify Checksums in Transport Global 
Select INSTALL NAME:    BEDD DASHBOARD 2.0     Loaded from Distribution     
Loaded from Distribution  1/19/15@10:04:38 
     => BEDD DASHBOARD 2.0  ;Created on Jun 04, 2014@20:53:28 
 
This Distribution was loaded on Jan 19, 2015@10:04:38 with header of  
   BEDD DASHBOARD 2.0  ;Created on Jun 04, 2014@20:53:28 
   It consisted of the following Install(s): 
BEDD DASHBOARD 2.0 
 
Want each Routine Listed with Checksums: Yes//   YES 
DEVICE: HOME//   Virtual 
 
PACKAGE: BEDD DASHBOARD 2.0     Jan 19, 2015 10:04 am                 PAGE 
1 
---------------------------------------------------------------------------
---- 
BEDD2ENV  Calculated    2546209 
BEDD2PST  Calculated    8173287 
BEDDEHR   Calculated    2045184 
BEDDEHRS  Calculated   21599952 
BEDDINJ   Calculated   17646764 
BEDDMREC  Calculated   32819285 
BEDDPOV   Calculated  117307512 
BEDDSYNC  Calculated   11113686 
BEDDTRPT  Calculated    6329164 
BEDDUTID  Calculated  171571970 
BEDDUTIF  Calculated     694696 
BEDDUTIL  Calculated  161512435 
BEDDUTIU  Calculated  130929002 
BEDDUTL1  Calculated     962138 
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   14 Routines checked, 0 failed. 
 
   1      Load a Distribution 
   2      Verify Checksums in Transport Global 
   3      Print Transport Global 
   4      Compare Transport Global to Current System 
   5      Backup a Transport Global 
   6      Install Package(s) 
          Restart Install of Package(s) 
          Unload a Distribution 
 
You have 2 PENDING ALERTS 
          Enter  "VA to jump to VIEW ALERTS option 
 
You've got PRIORITY mail! 
 
Select Installation Option: 6  Install Package(s) 
Select INSTALL NAME:    BEDD DASHBOARD 2.0     Loaded from Distribution     
Loaded from Distribution  1/19/15@10:04:38 
     => BEDD DASHBOARD 2.0  ;Created on Jun 04, 2014@20:53:28 
 
This Distribution was loaded on Jan 19, 2015@10:04:38 with header of  
   BEDD DASHBOARD 2.0  ;Created on Jun 04, 2014@20:53:28 
   It consisted of the following Install(s): 
BEDD DASHBOARD 2.0 
Checking Install for Package BEDD DASHBOARD 2.0 
Will first run the Environment Check Routine, BEDD2ENV 
 
                        Patch "AMER*3.0*6" is installed.                         
 
Install Questions for BEDD DASHBOARD 2.0 
 
Want KIDS to INHIBIT LOGONs during the install? NO//  
Want to DISABLE Scheduled Options, Menu Options, and Protocols? NO//  
 
Enter the Device you want to print the Install messages. 
You can queue the install by enter a 'Q' at the device prompt. 
Enter a '^' to abort the install. 
 
DEVICE: HOME//   Virtual 
  
 Install Started for BEDD DASHBOARD 2.0 :  
               Jan 19, 2015@10:04:56 
  
Build Distribution Date: Jun 04, 2014 
  
 Installing Routines: 
               Jan 19, 2015@10:04:57 
  
 Running Post-Install Routine: PST^BEDD2PST 
  
 Updating Routine file... 
  
 Updating KIDS files... 
  
 BEDD DASHBOARD 2.0 Installed.  
               Jan 19, 2015@10:04:59 
  
 Not a VA primary domain 
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Install Completed 

Figure 4-8: Sample Installation 
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5.0 Installation Configuration 

5.1 Add User Security Keys 
This section covers entering the appropriate security key to RPMS users requiring 
access to the BEDD package. If version 1.0 of BEDD has already been installed in 
the past, this section can be skipped for existing EDD users. 

There are two keys installed as part of the KIDS build: 

• BEDDZMGR – Key for Manager access to the EDD application 

• BEDDZDASH – Key for User access to the EDD application 
Add user security keys to RPMS users using the XUKEYMGMT option as shown in 
Figure 5-1. 

 At the “OPTION NAME:” prompt, type KEY MAN and press Enter. 1.

 At the “CHOOSE 1-2:” prompt, type 1 (XUKEYMGMT) and press Enter. 2.

 At the “Select Key Management Option:” prompt, type ALLOC and press Enter. 3.

 At the “Allocate Key:” prompt, enter BEDDZDASH and press Enter. 4.

 If the user also needs Manager access to this application, at the “Allocate Key:” 5.
prompt re-appears after the previous step, enter BEDDZMGR and press Enter. 

 At the “Holder of Key:” prompt, enter the user’s name to which the key(s) are to 6.
be added and press Enter. 

 At the “You are allocating keys. Do you wish to proceed?” prompt, verify your 7.
entry and type YES if correct or NO if not, and press Enter. 
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Select OPTION NAME: KEY MAN                                                  
     1   KEY MANAGEMENT  XUKEYMGMT     Key Management                  
     2   KEY MANAGEMENT  BEHOORKY MAIN     Key Management               
CHOOSE 1-2: 1  XUKEYMGMT     Key Management                              
                                                                      
                                                                         
          Allocation of Security Keys                                     
          De-allocation of Security Keys                                  
          Enter/Edit of Security Keys                                     
          All the Keys a User Needs                                      
          Change user's allocated keys to delegated keys                 
          Delegate keys                                                
          Keys For a Given Menu Tree                                     
          List users holding a certain key                                   
          Remove delegated keys                                           
          Show the keys of a particular user                                
                                                                           
Select Key Management Option: ALLOCation of Security Keys                  
                                                                           
Allocate key: BEDDZDASH                                                  
                                                                             
Another key: BEDDZMGR                                                    
                                                                         
Another key:                                                              
                                                                           
Holder of key: USER,TEST                                              
                                                                             
Another holder:                                                           
                                                                       
You've selected the following keys:                                        
                                                                        
BEDDZMGR       BEDDZDASH                                              
                                                                           
You've selected the following holders:                                    
                                                                           
USER,TEST                                                               
                                                                            
You are allocating keys.  Do you wish to proceed? YES//                   
                                                                        
BEDDZMGR being assigned to:                                                
     USER,TEST                                                            
                                                                          
BEDDZDASH being assigned to:                                                
     USER,TEST    

Figure 5-1: Key Management – Allocate Key(s)         

5.2 Configuring the Cache Server Page (CSP) Application 
Note: It is recommended that the site use a standalone Internet 

Information Services IIS or Apache™ web server with 
Secure Sockets Layer (SSL) configuration and not the 
private web server provided by InterSystems. The 
instructions here are meant to be used for testing purposes 
only. 
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Next, configure the security settings for the EDD CSP application which was 
automatically created by the import and compile process. If you do not complete this 
step, your Electronic Health Record Graphical User Interface (GUI) application will 
not be able to display the EDD’s main dashboard page. 

5.2.1 Enable System Authentication Options 
 Sign on to the Ensemble System Management Portal 1.

 Select Security Management under System Administration in the left column. 2.
The Security Management page will be displayed. 

 Select System Security Settings under Security Definitions in the left column. 3.
The Security Setting Options page will appear. 

 Select Authentication Options in the left column. The screen in Figure 5-2 will 4.
appear. 

 
Figure 5-2: Home->Security Management->Systems Security Settings->Authentication 

 Make sure that the Allow Unauthenticated access box is checked then click 5.
Save. The change will take effect immediately. 

5.2.2 Create New CSP Application 
 Return to the main Ensemble Management Portal page. Select Security 1.

Management under System Administration in the left column. The Security 
Management page will be displayed. 

 Select CSP Applications in the right column under Application Definitions. A 2.
page similar to Figure 5-3 will appear. 
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Figure 5-3: CSP Applications screen 

 Select Create New CSP Application and fill out the values similar to Figure 5-4.  3.
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Figure 5-4: Edit CSP Application screen 

 For CSP Application Name put in /csp/bedd 4.

 Description is ED Dashboard 5.

 For Allowed Authenticated Methods make sure Unauthenticated is checked 6.

 For Namespace, select the site’s RPMS namespace 7.

 For CSP Files Physical path, locate the directory as 8.
<cacheinstance>/csp/<RPMSinstance> 
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 For Login Page, put in BEDDLogin.csp (this is case-sensitive) 9.

5.2.3 Update Ensemble’s UnknownUser 
 Return to the main Ensemble Management Portal page. Select Security 1.

Management under System Administration in the left column. The Security 
Management page will be displayed. Select "Users" in the left column and the 
following page similar to Figure 5-5 will appear. 

 
Figure 5-5: User Management screen 

 Locate the user called UnknownUser on this screen. Once found, click the Edit 2.
link. A screen similar to Figure 5-6 will appear. 
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Figure 5-6: Edit User screen 

 Click the Roles tab immediately under Edit definition for user UnknownUser 3.
and the Edit User screen similar to Figure 5-7 will appear. 
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Figure 5-7: Edit User 

 If the list of roles which appears at the top of the page immediately under 4.
UnknownUser is Assigned to the Following Roles includes %All, then no 
further action in this section is required. If not, then select %All in the list of 
Available roles on the left hand side of the page, and click the top arrow located 
between the Available and Selected columns.  

 Once %All appears in the Selected column, click the Assign button and %All 5.
will appear under UnknownUser is Assigned to the Following Roles. 

 The CSP application portion and security setup is complete.  6.

5.3 CSP Gateway Installation 
The CSP Gateway provides the communications layer between the hosting Web 
server and Ensemble when you call a Caché® Server Page (CSP). The purpose of 
using the CSP Gateway is to offload the access to the EDD application to a dedicated 
web server, as well as use SSL communication to encrypt the data between the user 
and the server.  



IHS Emergency Department Dashboard (BEDD) Version 2.0 

Installation Guide and Release Notes Installation Configuration 
June 2015 

22 

Note: The instructions in this section assume the site is running 
Microsoft Internet Information Server (version 7 or higher) 
with a valid installed SSL certificate. Installation of IIS and 
SSL certificates are outside the scope of this document. 

5.3.1 Install Cache Shell 
 Start by launching the Ensemble executable appropriate for your version of 1.

Windows and checking I accept the terms in the license agreement and click 
Next as indicated in Figure 5-8. 

 
Figure 5-8: Ensemble Installation 

 Enter a unique Ensemble Instance Name for this physical machine and click Next 2.
as indicated in Figure 5-9. 
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Figure 5-9: Ensemble Installation cont’d 

 On the next screen, enter the path where the Ensemble shell will be located by 3.
clicking Change as shown in Figure 5-10. 

 
Figure 5-10: Ensemble Installation cont’d 
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 Install into the directory C:\InterSystems\EnsembleCSP and click OK as 4.
indicated in Figure 5-11. 

 
Figure 5-11: Ensemble Installation cont’d 

 Select Web Server on the next screen and click Next as indicated in Figure 5-12. 5.
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Figure 5-12: Ensemble Installation cont'd 

 A screen will appear as in Figure 5-13 allowing a review of the options. Review 6.
and click Install.  



IHS Emergency Department Dashboard (BEDD) Version 2.0 

Installation Guide and Release Notes Installation Configuration 
June 2015 

26 

 
Figure 5-13: Ensemble Installation cont’d 

 If IIS is running you will receive a warning message asking you to stop the IIS 7.
WebServer as seen in Figure 5-14. Click Yes and it will stop IIS and continue the 
installation process. 

 
Figure 5-14: Ensemble Installation cont’d 

 Click Finish to complete the installation as indicated in Figure 5-15. 8.
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Figure 5-15: Ensemble Installation cont’d 

5.3.2 Configure IIS 
 On the webserver that the CSP gateway was just installed, go the option 1.

Administrative Tools -> IIS Manager as indicated in Figure 5-16. 
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Figure 5-16: Ensemble Installation cont’d 

 Select Default Web Site, click csp, then Handler Mappings as indicated in 2.
Figure 5-17. 
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Figure 5-17: IIS Handler Mappings 

 Validate that the CSPGateway_* mappings are present for *.cls, *.csp, *.cxw 3.
and *.zen, and that they are listed as Enabled as indicated in Figure 5-18. 
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Figure 5-18: IIS Handler Mappings cont’d 

 In order to have IIS handle CSP applications like EDD via IIS, click Add Module 4.
Mapping and enter values as indicated in Figure 5-19.  
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Figure 5-19: IIS Handler Mappings cont’d 

5.3.3 Configure CSP Gateway 
 While connected to the server where the CSP Gateway was installed, enter the 1.

following link in a web browser: http://localhost/csp/bin/Systems/Module.cxw 
and the screen shown in Figure 5-20 will appear. 

 
Figure 5-20: CSP Gateway configuration 

http://localhost/csp/bin/Systems/Module.cxw
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 Click Server Access and Add Server as indicated in Figure 5-21. 2.

 
Figure 5-21: CSP Gateway configuration cont'd 

 Insert the appropriate site information in the highlighted areas on the following 3.
screen as indicated in Figure 5-22, and click Save Configuration at the bottom 
when complete. 

 
Figure 5-22: CSP Gateway configuration cont'd 

 Click Application Access and Add Application as indicated in Figure 5-23. 4.
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Figure 5-23: CSP Gateway configuration cont'd 

 On the following screen, for Application Path: set to /csp/bedd and for Default 5.
Server: select your previously configured server name from the dropdown, then 
click Save as indicated in Figure 5-24. 

 
Figure 5-24: CSP Gateway configuration cont'd 

 Click Test Server Connection. If successful the following screen will appear 6.
similar to Figure 5-25. 
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Figure 5-25: CSP Gateway configuration cont'd 

 Enter the website link for the ED Dashboard from a workstation browser, for 7.
example: https://npacsmtbmw.d1.na.ihs.gov/csp/bedd/BEDDLogin.csp 
 and the page as shown in Figure 5-26 will appear.  

 
Figure 5-26: CSP Gateway configuration cont'd 

Note: If you are using a non-standard port for the https protocol 
handled by IIS such as 444, you will need to modify the 
URL you use accordingly as in the following xample: 
https://npacsmtbmw.d1.na.ihs.gov:444/csp/bedd/BEDDLog
in.csp 

https://npacsmtbmw.d1.na.ihs.gov/csp/bedd/BEDDLogin.csp
https://npacsmtbmw.d1.na.ihs.gov:444/csp/bedd/BEDDLogin.csp
https://npacsmtbmw.d1.na.ihs.gov:444/csp/bedd/BEDDLogin.csp


IHS Emergency Department Dashboard (BEDD) Version 2.0 

Installation Guide and Release Notes Installation Configuration 
June 2015 

35 

5.4 Application Access Setup 
There are two modes of operation for the EDD: Standalone and EHR Portal.  

 Standalone - access via a direct web browser session which requires an active 1.
RPMS Access and Verify code to login. 

 EHR portal - access from within the EHR application as separate tab. Note that 2.
this also requires an active RPMS Access and Verify code to login, however the 
user may already have their credentials cached in the EHR application. 

5.4.1 Stand Alone Setup  
For Standalone access, create an icon on your desktop to call up your web browser for 
access: 

 On your desktop, right-click and choose New - > Shortcut (Figure 5-27) and 1.
enter the following URL (site-specific modifications in BOLD type):  

http://IPADDRESS:PORT/csp/bedd/BEDDLogin.csp 

IPADDRESS is the IP name or Address of your Ensemble installation or CSP 
Gateway 

PORT is the port number used for the portal or gateway 

Note: Modify the URL to HTTPS if you are using a CSP gateway 
with an active and signed HTTPS encryption certificate. 

http://IPADDRESS:PORT/csp/bedd/BEDDLogin.csp
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Figure 5-27: Add Desktop Shortcut 

 After entering the URL, press Next as in Figure 5-28 2.

 
Figure 5-28: Enter URL for shortcut 

 In the Type a name for this shortcut: prompt, enter ED Dashboard and click 3.
Finish as indicated in Figure 5-29. 
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Figure 5-29: Name Shortcut 

 Click the new icon to test as indicated in Figure 5-30. 4.

 
Figure 5-30: Dashboard Login Page 

5.4.2 EHR Setup 
For access to the EDD from the EHR, the following steps need to be performed in the 
Design Mode of the EHR application:  
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 Open EHR, right-click in the title bar at the top and choose Design Mode as 1.
indicated in Figure 5-31. 

 
Figure 5-31: Enter design mode 

 Select Design -> Desktop Properties as displayed in Figure 5-32. 2.



IHS Emergency Department Dashboard (BEDD) Version 2.0 

Installation Guide and Release Notes Installation Configuration 
June 2015 

39 

 
Figure 5-32: Desktop Properties 

 Select Customize Menus as displayed in Figure 5-33. 3.
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Figure 5-33: Customize Menus 

 Click the plus sign (+) to add and enter a new menu option ED Dashboard as 4.
seen in Figure 5-34 and Figure 5-35. 
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Figure 5-34: Customize Menus cont’d 

 
Figure 5-35: Customize Menus cont’d 
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 In the Edit Action Box, put in the path to Internet Explorer followed by a space 5.
and the regular EHR URL as seen in Figure 5-36, where an example value is 
given. Replace IP address and PORT values with those appropriate for your site. 

“C:\Program Files\Internet Explorer\iexplore.exe http://IPaddress:PORT  
csp/bedd/BEDDLogin.csp?DUZ=$(user.handle)&SITE=$(site.handle)&LOC=EH
R 

 
Figure 5-36: Edit action 

 Click OK, Save Settings and leave design mode. 6.

 Click on the new menu option ED Dashboard, and the EDD main screen will 7.
display as indicated in Figure 5-37. 
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Figure 5-37: gv bff Dashboard Display 
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Acronym List 

Acronym Term Meaning 
CSP Cache Server Page 

EDD Emergency Department Dashboard 

EHR Electronic Health Record 

ERS Emergency Room System 

GUI Graphical User Interface 

IHS Indian Health Service 

IIS Internet Information Services 

RPMS Resource and Patient Management System 

SSL Secure Sockets Layer 
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Contact Information 

If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (888) 830-7280 (toll free) 

Web: http://www.ihs.gov/helpdesk/ 

Email: support@ihs.gov 

http://www.ihs.gov/helpdesk/
mailto:support@ihs.gov
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